
ApexSQL Script  

Version 2020.x 

Release Notes and Requirements 

 

System requirements 

Hardware Dual Core 2.0 GHz CPU 

3 GB memory 

167 MB disk space 

SQL Server SQL Server 2005 and higher [1] 

Azure SQL Database [1] 

Amazon RDS for SQL Server [1] 

OS Windows 7 SP1 / Windows Server 2008 R2 SP1 and higher [1] 

Software .NET Framework 4.7.2 or higher 

Note Source control integration available for Azure DevOps [4], Git [5], 

Mercurial [5], Subversion [5] and Perforce [5] 

Permissions and 

additional requirements 

Windows user account with administrative privileges 

 

See Minimum permissions required to install and use ApexSQL 

products 

 

See Minimum SQL Server permissions for ApexSQL Developer tools 

 

See Remote access for SQL Server instance 

[1] See Supported systems for exact version support 

[4] Azure DevOps Server (TFS) [5] / Azure DevOps Services 

[5] Up to the latest version 

https://support.microsoft.com/en-us/help/4054530/microsoft-net-framework-4-7-2-offline-installer-for-windows
https://blog.apexsql.com/source-control-support-for-apexsql-products/
https://knowledgebase.apexsql.com/minimum-permissions-required-to-install-apexsql-products/
https://knowledgebase.apexsql.com/minimum-permissions-required-to-install-apexsql-products/
https://knowledgebase.apexsql.com/minimal-sql-server-permissions-apexsql-developer-tools/
https://knowledgebase.apexsql.com/configure-remote-access-connect-remote-sql-server-instance-apexsql-tools/
https://www.apexsql.com/supported-software.aspx


 

Supported Software 

Windows version 

Windows 7 SP1 & 

Windows Server 

2008 R2 SP1 

Windows Server 

2012 

Windows 8.1 & 

Windows Server 

2012 R2 

Windows 10 & 

Windows Server 

2016 

Windows Server 

2019 

     

 

SQL Server version [4] 

 2005 2008 2012 2014 2016 

2017 2019 CTP 3 

Windows Linux [3] Windows Linux [3] 

ApexSQL 

Script  

         

 

SQL Server edition [4] 

 Express Standard Enterprise 

Azure SQL Database 

Amazon RDS 

for SQL Server 
Single 

Database,  

Elastic Pool 

Managed 

Instance 

ApexSQL 

Script  

      

 

Source control systems 

https://www.apexsql.com/sql-tools-script.aspx
https://www.apexsql.com/sql-tools-script.aspx
https://www.apexsql.com/sql-tools-script.aspx
https://www.apexsql.com/sql-tools-script.aspx


 
Azure 

DevOps [6] 
Git [7] Mercurial [7] Perforce [7] Subversion [7] 

ApexSQL 

Script  

     

[3] Tested on Ubuntu 16.04 

[4] Including Amazon EC2, Google Compute Engine, and Azure Virtual Machine cloud computing 

SQL Server instances 

[6] Azure DevOps Server (TFS) [7] / Azure DevOps Services 

[7] Up to the latest version 

 

Getting Started 

For further information about installation and getting started, please check the Quest Knowledge Base 

or ApexSQL Getting Started. 

 

Release Notes (release history) 

Release: 2020.02.0486 

Date: September 16, 2020 

Fixes: 

 183811: "Parse error: Incorrect syntax near 'RANGE'" error is encountered when attempting to 

script the SQL database 

 183812: SQL databases are not loaded when using SQL Server 2008 

 185359: The output script doesn't include a begin transaction at the top of the script when 

generating individual scripts into a folder 

 

Release: 2020.01.0482 

Date:  March 2, 2020 

 

Enhancements: 

 SQL Server 2019 support 

 Temporal tables support 

https://www.apexsql.com/sql-tools-script.aspx
https://www.apexsql.com/sql-tools-script.aspx
https://support.quest.com/apexsql-Script/kb
https://www.apexsql.com/getting_started.aspx
https://www.apexsql.com/sql_tools_readme.aspx?Product=Script
https://blog.apexsql.com/sql-server-2019-ga-support-for-apexsql-products/


 SQL graph tables support 

 Application telemetry now collects anonymous data on the use and performance of 

applications and application component 

 ApexSQL Updater is added for configuring advanced updating settings of all installed 

ApexSQL products 

Fixes: 

 Empty folder structure is generated in the temporary folder and the folder is generated in the 

wrong location when committing scripts to the Team Foundation Server repository 

 The application stops responding when scripting out filtered list of triggers from Amazon 

RDS database 

 Applying schema or object name column filters in objects lists does not affect the list 

 Data is not scripted with the Structure and data scripting mode selected when the Object 

filter is set after loading a database 

 "Make sure correct username and password are specified" message is encountered when 

establishing connection to the Git repository hosted on the Azure DevOps 

 Blank error dialog is shown when all the files are deleted from Team Foundation Server 

repository and commit is started again 

 The application is not automatically closed during the update process 

 Performance drop when scripting a database with 200+ users and permissions on all objects 

for them 

 "Parse error: [Incorrect syntax near 'WITH'] at" error is encountered when the Script process is 

initiated with the Structure and data scripting mode and a table included has the with fill-

factor value 

 Database and column collation are changed, and SQL Server default collation is used when 

creating a database from a created executable installer 

 "Method not found: 'Void DevExpress.XtraTreeLis" error is encountered when saving the 

project file 

 Date and time are not changed for the file name in the Script wizard after one scripting 

process is finished and another one is started 

 Filter editor under the Object filter panel in the main application window is not working 

 Underscores are not added when the Date and Time tags are added for the file name under 

the Output tab of the Options window 

 "Object reference not set to an instance of an object" error is encountered when scripting out 

a database to a script folder 

 Missing statements to create filegroups for objects that uses them when the Filegroups 

option under the Structure section of the Options tab in the New project window is checked 

and output to script folder is selected 

 Authentication type is automatically changed to the Active Directory - Universal with MFA 

support authentication when changing SQL Server 

 Missing the Active Directory - Universal with MFA support authentication for the Connection 

to SQL Server dialog under the Integrated editor 

 Missing source control connection parameters when generating automation script for 

scripting to a local Git repository 

https://knowledgebase.apexsql.com/telemetry-in-apexsql-products/
https://knowledgebase.apexsql.com/telemetry-in-apexsql-products/
https://knowledgebase.apexsql.com/how-to-auto-update-apexsql-tools-add-ins/
https://knowledgebase.apexsql.com/how-to-auto-update-apexsql-tools-add-ins/


 “Repository not found: C:\Users\Username\AppData\Local\ApexSQL\ApexSQL Script\" error 

is encountered when scripting database to the local Git repository 

 Objects are not shown in the main application window when SQL Server 2008 database is 

loaded 

 Pre and Post processing scripts are not included in the scripting process when the Use 

embedded option is selected under the Additional scripts tab of the New project window 

 Object type selection in the Object filter tab of the New project window is reset when any 

selection is made, a tab is switched and then the Object filter tab is selected again 

 Database with its objects and data remains in the Structure and Data grids in the main 

application window, even though the project is edited, and other database is checked for 

loading, while the first one is unchecked 

 The last used path for the automation script is not remembered 

 "Object reference not set to an instance of an object" error is encountered when configuring 

scripting target source control parameters after second database is loaded in same 

application session 

 Missing the option to exclude specific objects through the CLI 

 Static data is not scripted for tables that do not have primary key defined 

Changes: 

 Dark theme is now used as the default application theme 

 Save as dialogs are now inheriting the application theme 

Release: 2018.04.0452 

Date:  June 21, 2019 

Changes: 

 Software Transaction Agreement is added as a new step in the installation wizard and 

updated in accordance with https://www.quest.com/legal/sta.aspx 

 

Release: 2018.04.0447 

Date:  April 23, 2019 

Enhancements: 

 Active Directory support for: 

o Password authentication 

o Integrated authentication 

o Universal with MFA support authentication 

 Visual Studio 2019 version option is added for the C# solution and Executable installer 

options steps in the Script wizard 

 CLI switches: 

o Login for Azure Active Directory authentication [/ad] 

https://www.quest.com/legal/sta.aspx
https://blog.apexsql.com/using-apexsql-tools-with-azure-active-directory-authentication/
https://blog.apexsql.com/using-apexsql-tools-with-azure-active-directory-authentication/
https://blog.apexsql.com/using-apexsql-tools-with-azure-active-directory-authentication/
https://blog.apexsql.com/using-apexsql-tools-with-azure-active-directory-authentication/


o New value for the Visual Studio /vs_ver switch: VS2019 

Fixes: 

 "ExecuteScalar requires an open and available Connection. The connection's current state is 

closed" error is encountered in the log file when Azure SQL Database or Amazon RDS for SQL 

Server is loaded, even though there is no error in the application’s GUI 

 "Object reference not set to an instance of an object" error is encountered when the OK 

button is clicked in the Connection options dialog after changing value for timeout options 

 The created C# solution is not opened upon creating it through the CLI, even though the 

/open_vs switch is specified 

 The created executable installer is not opened upon creating it through the CLI, even though 

the /run_exe_now switch is specified 

 The Disable all triggers and constraints prior to loading data option switch is not working in 

the CLI 

 "Could not load file or assembly" error is encountered during the commit process to the 

Team Foundation Server repository 

 "Index 4 is out of range" error is encountered when the Clear filter button is clicked in the 

Object filter panel of the main application window 

Changes: 

 Where clause dialog and column under the Data view are now Row filter 

 

Release: 2018.03.0425 

Date:  February 22, 2019 

Fixes: 

 The Extend evaluation button does not open default e-mail client when clicked and the 

application is opened in the Community edition 

 Objects and data are scripted to the same StaticData folder when more than one database 

schema and data is selected for scripting 

 Randomly named project are created when an existing one is deleted from the Team 

Foundation Server repository 

 "Source control error: One or more errors occurred" error is encountered when creating new 

project on Team Foundation Server repository 

 

Release: 2018.02.0418 

Date:  December 18, 2018 

Enhancements: 



 SQL Server 2019 CTP 2.0 support 

 High DPI and 4K resolution support 

 Save automation script as a PowerShell script 

 New error handling and send logs functionality 

 Improved application installer with a dark theme 

 New application icon 

 Check for object existence with If exists/If not exists option is added under the Options tab of 

the New project window 

 Include dependent database objects option is added under the Options tab of the New 

project window 

 CLI switches: 

o Name of the executable installer or C# solution package [/pknm] 

o Output name/folder path of the SQL script, script folder or executable packages [/on] 

Fixes: 

 "Source control error: Comment cannot be empty" error is encountered while creating new 

project for Mercurial source control without entering a comment 

 "There was an error when processing files. The directory is not empty" error message is 

encountered when committing to Subversion and Git project label 

 "The path is not of a legal form" error is encountered when running executable installer if it 

was created with the Use compression option and saved in the ApexSQL Script installation 

folder 

 "Source control project path is not specified" error is encountered when running the CLI to 

commit objects/data without the /scj switch for setting up the source control project 

 "Source control working folder is not specified" error is encountered when omitting the 

switch for the working folder 

 Executable installer cannot execute a script to create a database on Azure SQL Database V12 

 "Failed to commit operation with message 'No pending changes'" error is encountered when 

creating a subproject on Team Foundation Server repository 

 Triggers are not being disabled or re-enabled when scripting only data 

 "Parse error: Incorrect syntax near '@SB'" is encountered when scripting a stored procedure 

that contains uniqueidentifier 

 Creating of new projects from the Source control wizard for the latest version of Mercurial 

source control system 3.9 and above is not working 

 Labels are applied to each commit to source control repository, even when label is not 

provided in the Output file window 

 "Please check the 'Script create database' option in project defaults" message is shown when 

the Use for database option is checked in the Options tab and the Alter database name is 

checked in the SQL script options step of the Script wizard 

 "NGit.Errors.TransportException: https://UserName@bitbucket.org/UserName/citest.git: not 

authorized" error is encountered while committing objects to Git repository from the CLI 

 "Login failed for user 'sa'" error is encountered when /user and /password switches are used 

in the CLI to override settings in the project file 

https://blog.apexsql.com/4k-resolution-and-high-dpi-scaling-support-in-apexsql-tools-add-ins/
https://knowledgebase.apexsql.com/save-project-as-automation-script/
https://knowledgebase.apexsql.com/how-to-send-log-files-from-apexsql-tools/
https://blog.apexsql.com/the-new-apexsql-installer/
https://blog.apexsql.com/apexsql-tool-icons-screenshot-tour/


 "Switch '/scusr (/sourcecontrol_user)' can only be used with a switch '/sctype 

(/sourcecontrol_type)'" error is encountered when the /scusr and /scpwd switches are 

specified with the /project switch 

 The application commits data for tables to the source control repository that were only 

checked in the Structure view 

 "Could not load file or assembly 'Newtonsoft.Json, Version=7.0.0.0...' or one of its 

dependencies. The system cannot find the file specified" error is encountered when the Test 

or Finish button is clicked once all system logins are provided for Team Foundation Server 

repository 

 The Branch option is wrongly loaded as the /csbr switch in the Save as batch window 

 The Create database option is wrongly loaded as the /scr_create_d switch in the Save as 

batch window 

 Objects are showed for scripting, even if they were deselected in the Object filter tab after 

editing the current project 

 Incorrect CLI switches are created for the Disable all triggers and constraints and Apply date 

format options in the Save as batch window 

 CLI switch /owner_type is showed twice in the Save as batch window 

 "Bad format of switch: /owner_map" error is encountered in the CLI after loading the created 

batch script that contains the Owner mapping option 

 Switches /no_transaction_handling and /no_format_scr_header are created in the Save as 

batch window, but cannot be used when the output type is C# solution or Executable 

installer 

 "Bad format of switch: /db_size" error is encountered in the CLI after loading the created 

batch script that contains the database size option 

 "Bad format of switch: /package_author" error is encountered in the CLI after loading the 

created batch script that contains the Author option for the Optional package information 

 Missing the back-slash (/) before the /owner_type switch in the Save as batch window 

 "Source control error: Cannot checkin pending changes 'The array must contain at least one 

element'" error is encountered while committing a database to a Team Foundation Server 

repository 

 "Could not load file or assembly" error is encountered when the Browse button is clicked to 

select a project for a Git repository hosted by Visual Studio Online 

 The /exclude switch is not working when specific object type needs to be excluded 

 The excluded schema is not shown in the script even though it was shown and checked in 

the Include dependent database objects step of the Scripting wizard 

 "Could not load file or assembly " error is encountered when the Browse button is clicked to 

choose project for all source control systems 

 "Database is not specified" message is shown in the CLI when exporting CLI help file to HTML 

 Wrong alias is used for the project file switch in the CLI 

 Missing output types and wrong naming of the existing ones in the CLI 

 Missing and wrongly named compatibility levels for the /db_compatibility_level CLI switch 

 Missing and wrongly named Visual Studio versions for the /vs_ver CLI switch 

 When trying to open a project from the Recent projects option in the New project window 

nothing happens, even though there is recent project created and present 

 Object filter is not filtering the selected objects once the Load button is clicked 



 The Setup button in the Source control options of the Script wizard is not working after 

closing and re-opening the Source control wizard 

 The application stops working when the X button is clicked in the main application window 

after editing the project options 

 The application can be uninstalled even when it's running 

 The Row filter not shown for the Structure view and its button is under the wrong group in 

the View tab 

 Missing the Default collation and SQL Server version options under the Source control 

options step of the Script wizard 

 Pre and post processing scripts cannot be set both at once 

 "Could not load file or assembly 'SharpSvn" error is encountered when the Browse button is 

clicked to select project for the Subversion source control repository 

 Static data is not committed to source control repository when any source control system is 

used 

 "The version of the selected solution is higher than the solution version supported by this 

Visual Studio release" message is shown when Visual Studio 2017 version is selected in C# 

solution options in the Script wizard and the created solution is opened 

 Object header and Pre-script options are loaded and checked by default in the Save as batch 

window even though these were not set in the project 

 "Arguments can be combined in output_elements switch" error is encountered while 

exporting the CLI help file into HTML 

 Wrong CLI switch is used for the output name in the Save as batch window when SQL script 

is selected as the output type 

 Wrong switches are generated and missing switches in the Save as batch window when the 

Script folder is selected as the output type 

 Wrong switches are generated and missing switches in the Save as batch window when the 

Source control is selected as the output type 

 Wrong switches and values are generated and missing switches in the Save as batch window 

when the C# solution is selected as the output type 

 Wrong switches and values are generated and missing switches in the Save as batch window 

when the Executable installer is selected as the output type 

 "The server was not found or was not accessible" error is encountered in continuous loop 

when loading the project file with saved connection that does not exist any more 

 "Enter username and password" message is shown when a project file from the previous 

major version is loaded that contains saved user name and password for SQL Server 

authentication 

 Structure and data options under the Options tab of the New project window are not saved 

in the project file and therefore default options are loaded along with the loaded project file 

 Previously saved SQL Server credentials in the project file are not loaded along with the 

project file 

 The Save as my defaults button doesn't saves custom options under the Options and 

Package tabs in the New project window 

 Wrong project name is loaded in the Batch script panel when the project file is saved in the 

Save as batch window 

 Wrong default project name is shown when the Save button for the project file is clicked in 

the Save as batch window 



 Project file with a wrong name is saved along with the created batch file 

 "File doesn't exist or is of incorrect format" error is encountered when the saved project file is 

run through the CLI 

 "Cannot connect to 'Server.Name'. The target principal name is incorrect" error is 

encountered when the previously saved project file with Azure SQL Database connection 

credentials is opened and the Connect button is clicked 

 The Save as batch window is closed when the Cancel button is clicked in the Save as window 

 Default settings are not correctly checked for the Apply date format under Options tab in the 

New project window after the application installation 

 "Branch name is not allowed" error is encountered while committing objects to a source 

control repository via the CLI 

 SQL output script is created with no data rows when the Where clause option is used to filter 

rows 

 Static data is not committed to a source control repository through the GUI 

 Package and Additional tabs, along with Script folder, Source control, C# solution and 

Executable installer output types are not available in the Evaluation period 

 The /output_name switch is missing in the Batch script panel when executable installer or C# 

solution are selected as output type 

 The Date and Time tags are not formatted correctly in the Save as batch window for the 

/package_name switch 

 Wrong branch name is set for the /scb switch when Git source control repository is set in the 

Save as batch window 

 Redundant /scf CLI switch is loaded in the Batch script panel when source control is selected 

as the output type 

 Missing quotation marks for the /scr and /scj switches in the Save as batch window when 

source control is selected as the output type 

 Missing value for the /scr switch and missing /scj switch in the Save as batch window when 

Perforce source control information are loaded 

 "Connecting to source control server [localhost:1666] has failed Authentication was failed 

with message 'ProjectName is a depot, not a client" error is encountered while committing to 

the Perforce source control repository from the CLI 

 "The specified folder does not contain the appropriate folder structure" message is shown 

when a selected source control project contains the Assemblies folder 

 The Include dependent objects step is not shown when the Structure and data scripting 

mode is selected in the Script wizard 

 "Windows logins are not supported in this version of SQL Server" error is encountered when 

trying to save a Where clause while connected to Azure SQL Database 

 "The login is from an untrusted domain and cannot be used with Integrated authentication" 

error is encountered when trying to save a Where clause while connected to Amazon RDS for 

SQL Server 

 The Compatibility level option is not working in the GUI 

 The /db_compatibility_level switch is not working when run in the CLI 

Changes: 



 The application now requires Microsoft .NET framework 4.7.2 

 Save as batch is now Automation script 

 

Release: 2018.01.0333 

Date:  July 04, 2018 

Enhancements: 

 Visual themes 

 Visual Language Dictionary for Visual Studio for iconography and other imagery concepts 

applied 

 The “Manage Owners” option is added in the New Project form 

 CLI switches: 

o /on (/output_name) 

o /eso (/exclude_schema_objects) 

Fixes: 

 The Windows taskbar is not shown on mouse hover when the Auto-hide the taskbar option is 

checked and the application is maximized 

 The ''Row filter'' option is missing under the Structure view 

 The executable installer does not check if there is a previous version installed 

 The Run executable installer now option is unchecked when the Back button is clicked in the 

Export batch form 

 When adding pattern in the Object filter step of the wizard pattern should become active 

when checked 

 “loading objects failed” error is encountered if no database is selected when initiating 

Schema mapping or Object filter 

 Unresponsive progress forms when connecting data source selecting Schema mapping or 

Object Folder 

 The Create database option cannot be saved as "my defaults" in the connection form under 

the structure tab 

 Missing a prompt dialog whether to uninstall the previous version or cancel the current 

installation 

 Parsing errors keep reoccurring once encountered 

 “Automatic updates” options are not checked by the default in the application 

 Indicator of excluded objects doesn't respond in the status bar under Data tab 

 Indicator of excluded objects doesn't respond in the status bar under Structure tab 

 Lack of summary after scripting process 

 Missing the Logging option in the Package tab 

 The Working folder is redundant as a source control system 

 Missing line numbers in the Where clause window 

 Unable to execute file in temporary directory Setup is aborted when downloading and 

installing the application 

https://blog.apexsql.com/visual-themes-in-apexsql-tools/
https://blog.apexsql.com/visual-language-dictionary-for-visual-studio-for-iconography-colors-and-other-visual-concepts-applied-in-apexsql-tools-add-ins/
https://blog.apexsql.com/visual-language-dictionary-for-visual-studio-for-iconography-colors-and-other-visual-concepts-applied-in-apexsql-tools-add-ins/


 "Could not load file or assembly 'Newtonsoft.Json, Version=7.0.0.0...' or one of its 

dependencies. The system cannot find the file specified" error is encountered when the Test 

or Finish button is clicked once all system logins are provided for TFS 

 Objects still showing for scripting even if they were deselected in the Object filter 

 Compatibility level option is not saved in the project 

 "Parse error: [Incorrect syntax near 'READ']" error is encountered while parsing the procedure 

 Missing the /exclude_dependent_objects switch that will exclude objects that depend on the 

excluded objects specified in the /exclude 

 The license file disappears when virtual machine is stopped and then run on Amazon AWS 

 "Cannot insert duplicate key in object 'SchemaName.TableName'. The duplicate key value is 

(0)" error is encountered when executing the generated SQL script to create a trigger after 

renaming a table and creating a view on which trigger depends on 

 Wrong CLI switch is used for the output name in the Save as batch window when SQL script 

is selected as the output type 

 Arguments can be combined in output_elements switch error is encountered while exporting 

the CLI help file into HTML 

 Wrong switches and values are generated and missing switches in the Save as batch window 

when the solution is selected as the output type: 

o C# 

o Executable installer 

o Script folder 

o Source control 

 The application stops working when the Commit button is clicked with Source control as the 

Output type without providing source control credentials 

 The Create database option cannot be saved as "my defaults" in the connection form the 

structure tab 

 When using dual setup monitor environment application starts on the secondary monitor 

regardless if it was used on the primary 

Changes: 

 The application now requires Microsoft .NET framework 4.7.1 

 Windows Vista and Windows Server 2008 are no longer supported 

 The /pf switch is changed to /pr CLI switch 

 Removed /fl, /in, /fn, /sta, /stc, /stl, /stc1, /stc2 and /stc3 CLI switches 

 


